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Rockend SMS Online Quick Guide 

 Rockend SMS Online Set-up Checklist  

✓ Ensure you have received their “Rockend SMS Welcome Email” with login 
  details (if you don’t remember your password go to    
  www.rockendsms.com.au – Hint; your username is your email address –  
  then click on forgot password) 

✓ Sending Messages Outside of your Rockend Software 
 

1.1 Updating Rockend SMS Online Settings 
 Once set up, you will receive a welcome email from Rockend SMS indicating your account is 

now active. This email will include a user name, password and link to 

www.rockendsms.com.au To use Rockend Online, you will need to first login at 

www.rockendsms.com.au  

 
 To resend login details click on the “Forgot Password?” link.  Details will be emailed to your 

registered email address. 
 The password is case sensitive so ensure that it is entered correctly. 

 Add the Rockend SMS Online site to your list of Favourites by bookmarking it (Ctrl+D) 

 

 You can change your password by following the steps below. 

 

1.  Change Password – it is strongly recommended that the password is changed to 

something a little more personal and easily remembered.  

 To do so, go to Settings > Profile & Settings – click on Reset Password, type in your 

new password and click save. 

  

2.  It is also recommended that you populate your Profile if not already done, with 

your mobile number and other contact details. 
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1.2  Sender ID Options when sending through Rockend SMS Online 

 
Figure 3.1: SendSMS – Allow Replies ON/OFF 

 
  

ALLOW REPLIES - OFF 

a) Sender ID         
Including Landlines             
(No Replies) 

You have the ability to create a “mobile brand” by entering a 
minimum 5 and maximum 10 characters in the default reply string 
of Company Details. Message recipients CAN NOT reply to any 
messages that do not contain a valid mobile number. When using 
a landline number as the Sender ID the number must be in 
international format i.e 61295185955 

  
  

ALLOW REPLIES - ON  

b) Web Inbox               
(Replies come back to your 
Web Inbox) 

No message header choice- default data number. Use for auto 
STOP opt outs and for replies to come back into the Web Inbox 
and email.  

  

c) Own Number    
(Replies come back  to 
dedicated mobile) 

You are able to nominate a mobile number that replies can be 
directed to. This is generally a dedicated office phone that all 
senders have access to. 
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Rockend SMS Online Manual 

1  Introduction 
Rockend SMS Online will allow you to send text messages from your PC, mobile or tablet 

device (subject to GSM or wireless internet connection).  It has been designed to be easy-to-

use, and we trust that you will enjoy the experience. 

 

This user guide explains how to use the Rockend SMS application.  It covers: 

✓ Getting started 

✓ Sending an SMS 

✓ Using the personal contacts utility 

✓ Making the most of the tools available 

✓ Changing your password 

✓ Accessing the help functionality 

 

Each menu item is explained and illustrated with relevant screen shots. 

 

1.2  Terms and Abbreviation 
 

Rockend SMS Online A web-based application that allows a user to send SMS to a 
mobile phone user. 

  

Permissions Software restrictions imposed by the administrator on user 
groups. Restrictions can limit access to certain settings. 

  

SMS Short Message Service 

  

Administrator Person appointed within a company to manage user accounts and 
permissions. 
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2 About Rockend SMS Online 

The effectiveness of utilising SMS to better serve customers has been proven to marketing 

professionals, CRM specialists and business people. By improving your communication and 

client services, you are able to directly impact positively on business, increase revenues and 

reduce costs. 

  

The new suite of enhanced corporate messaging products will significantly change the way 

you communicate with your staff and clientele. 

 

With Rockend SMS Online you can send group or individual messages using a simple web 

interface from your PC, laptop or mobile device 

 

Rockend SMS Online allows for a quick, easy-to-use, cost effective means of keeping in touch 

with customers or staff.   

 

Rockend SMS Online noticeably reduces call time and costs by sending messages anytime, 

anywhere. 

 

Rockend SMS Online is ideal for promoting products and events, reminders and notification, 

and for realising real-time effective communication.  

 

The advantages of Rockend SMS Online are currently enjoyed by marketing and event 

managers, retail sales staff, customer service departments, executives, corporate secretaries 

and the mobile workforce at large. 

 

The benefits of Rockend SMS Online include: 

 

✓ Web-based application – requires no software installation and is accessible via the 

Internet from anywhere in the world. 

✓ Central management – reduces maintenance while automatically providing updated 

features and enhancements. 

✓ Reduced input time – it is far easier to type a message on a keyboard than on a 

handset keypad. 

✓ Customisation features – allow for corporate personalisation and implementation of 

user restrictions.  

✓ Bulk mail – messages can be sent to multiple recipients simultaneously, with the 

message body either generic or personalised. 

✓ Message scheduling – allows the date and time of message delivery to be pre-set, 

recurring at regular intervals or once only. 

 

Sending a message using Rockend SMS Online could not be easier.  Just follow these 3 easy 

steps: 

 

✓ Log into the web-based application 

✓ Create or select recipient 

✓ Compose and send message 
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3 Getting Started 

3.1  Logging In 
Before starting, ensure that you have been allocated a username and password.  This is 

emailed to you when your user details have been added. 

 

Access your login by clicking on the link provided in the Rockend SMS registration email.  

Enter your allocated user name and password, included in the registration email, in the 

relevant edit boxes. Click on the Login button to continue.  The Dashboard screen is 

displayed. 

 

If you are not sure of your local URL to access Rockend SMS Online, refer to the Contact 

Information at the back of this document.   

 

 Should you forget your user name and/or password, click on the “Forgotten 

Password?” button.  Your password will be emailed to your registered email 

address. 

 The password is case sensitive so ensure that it is entered correctly. 

 Add the Rockend SMS Online site to your list of Favourites by bookmarking it 

(Ctrl+D). 

 

3.2  Navigating Through Rockend SMS Online 

 
Figure 3.1: Main Menu/Dashboard 

 

Figure 3.2: Shortcuts Bar 
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Figure 3.1 shows the main menu found on the left hand of the screen area.  By clicking on 

the menu option with a drop down arrow, a sub-menu is displayed.  Click on the menu 

option to display the screen. 

 

Figure 3.2 shows the shortcuts bar – quick link to frequently used menu items.  

  

To sign out of Rockend SMS Online, click on the user icon in the upper right hand corner of 

the top bar and select sign out. 
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4 SMS Sending 

There are a number ways in which a text message can be sent using Rockend SMS Online.  

These include sending single messages, selecting a recipient or group from your contacts, cut 

+ paste numbers into the - enter number field, bulk messages, and Merge SMS messages.  

Messages can also be sent immediately or scheduled for a later send. 

 

4.1  How do I know if my message has been sent? 
All messages that have been sent are recorded in Reports. Access Reports in the main menu. 

Refer to section 8.1 for more information. 

 

4.2  Send SMS 
The Send SMS screen allows you to configure a message for personal contacts and groups, 

global contacts and groups, and individual recipients not saved in Contacts. 

 

For each message composed there is the ability to send the message immediately, or send 

the message later. 

4.2.1  Sending to Recipients from Contacts or Groups 
Access this screen by selecting SMS > Send SMS from the main menu.  

 

 

Figure 4.1: SMS Menu 
 

To search for recipients from personal or global contacts and groups, select the required tab 

from the build your list and add recipient’s box.     

 

From the list of contacts or groups that are displayed within the respective tabs, click the 

check box to select your contact or group. You can select all displayed recipients by selecting 

the Select All checkbox.  By clicking the checkbox your contacts or groups will be 

automatically added to the Recipient List.  

 

If a recipient is added accidentally, select the Recipient List tab and unselect the checkbox 

next to the contact or group. 
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 To clear the entire Recipient List, click on the Clear List button. 

 

Compose your message in the SMS Message text area, or select a Template from the drop-

down list. 

 

 To clear the message, just simply delete all content within the SMS Message text 

area. 

 

Sending the Message 

  

The following options are available: 

• To send the message immediately, click on the Send SMS button; 

• To send the message at a later date/time, click on the Schedule Options button 

(refer to section 4.4); 

 

! You will be prompted to acknowledge the terms and conditions of message 

sending in the final step of sending or scheduling. It is important at this point to 

review the total messages about to be sent. It is also important to ensure that you 

are abiding by all relevant marketing and privacy laws. 

 

! It is important that you only click “send campaign” once and wait for the screen to 

refresh. 

 

4.2.2  Sending to Recipients not in saved in your Contacts 
To send an SMS to people who are not saved in your contacts, use the Send SMS screen.   

Access this screen by selecting Send SMS from the SMS menu.  

 

In the Build Your List & Add Recipients box select Enter Recipients tab, type in the mobile 

number of the recipient/s.  If there is more than one recipient, press enter and enter the 

next number on the next line and continue to do so for each additional number. To Bulk 

send to recipients not saved in your contacts simply copy + paste your list of numbers from 

any source e.g. Word document, excel etc. into the Enter Number tab.  

 

When you click out of the Enter Number tab the numbers will be automatically added to 

your Recipient List this automatic process will clean your list and also give you a summary 

total of how many valid mobile numbers are ready to be sent.  

 

In the SMS Message text area, type the message for the recipient.  Remember that there is a 

limit of 160 characters.  The number of characters remaining is shown in the counter to the 

bottom left of the text area. You will be able to send more than 160 characters but you will 

be charged message credits at multiples of 160 characters this is displayed to the bottom 

right of the text area Message Parts – 1 Message Part = 160 characters. Ensure that you 

monitor the character count function under the message text box. 

 

If the message body is one that is used regularly, select a message template from the drop-

down list.  Refer to section 6.1 for details on how to create templates. 
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 To clear the message, just simply delete all content within the SMS Message text 

area. 

 

Sending the Message 

  

The following options are available: 

• To send the message immediately, click on the Send SMS button; 

• To send the message at a later date/time, click on the Schedule Options button 

(refer to section 4.4); 

! You will be prompted to acknowledge the terms and conditions of message 

sending in the final step of sending or scheduling. It is important at this point to 

review the total messages about to be sent. It is also important to ensure that you 

are abiding by all relevant marketing and privacy laws. 

 

! It is important that you only click “send campaign” once and wait for the screen to 

refresh. 

 

 

4.3  Configuring your Message and Replies 
Rockend SMS Online is designed to allow for a choice of how your recipients reply to your 

message 

 

 
Figure 4.1: Allow Replies OFF – Alphanumeric Sender ID 

 

 

 
Figure 4.2: Allow Replies ON – Replies to Web Inbox/Email or Mobile Number 
 

Rockend SMS Online allows you to configure your message to display a Sender ID (header) of 

your choice. This is an 11 character field allowing for text or numbers of your choice to be 
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the selected title or header of your message – No spaces or symbols are accepted in this 

field. You will need to have the Allow Replies button set to OFF to allow for an alphanumeric 

Sender ID. 

 

 When Allow Replies is set to OFF and an Alphanumeric Sender ID selected, 

recipients cannot reply to your message.  

 

You may however choose set Allow Replies to ON and have replies return to the Web Inbox. 

You will find your Web Inbox in the main menu. From your Web Inbox you have the ability 

to manage replies. You will need to have the Allow Replies button set you ON and Replies to 

Web Inbox/Email selected in the Sender ID drop down. Replies will simultaneously be 

delivered to the email inbox of the primary email address (username). 

 

Depending on the mobile number that is entered in your account details, you may choose to 

reply to Own Number (Sender ID drop down option). This means that your replies will come 

directly to your mobile phone. Any mobile numbers used as a Sender ID will need to be 

verified in Settings > Allowed Sender ID’s. 

 

4.4  Scheduling Messages 

4.4.1  Schedule Options – Once Off 
Access this screen from Send SMS by clicking on the Schedule Options > Once Off button. 

 

 
Figure 4.3: Once Off Scheduling 
 

Use this option to configure the message to be delivered at a pre-selected date and time 

only once.   

 

Select a date from the calendar on which the message is to be delivered.  If the message is to 

be sent next month, click on the Next > button on the calendar.  Enter the time by selecting 

the hour, minute and AM/PM from the drop down.   
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Click on the Save Schedule button and this will initiate the Confirmation required which 

includes the Scheduled Message Status displaying the date and time selected.  Clicking on 

Schedule Campaign will send your message at the scheduled date and time. Clicking on Close 

will take you back to allow you to make any changes. 

 

Once message schedules are created, they can be viewed in Scheduled SMS found on SMS > 

Schedule SMS in the main menu. 

4.4.2  Schedule Options – Repeat 
Access this screen from Send SMS by clicking on the Schedule Options > Repeat button. 

 

 
Figure 4.4: Repeat Scheduling 
 

When sending a message on a recurring basis, it can be configured to be sent on certain days 

for a period of time with the option of ending the recurring message on a date. Through 

these setting you can schedule messages to be sent daily, weekly, fortnightly, monthly or 

yearly. Select the required frequency from the Send on the following days and Send 

Frequency options. 
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 Figure 4.5: Repeat Scheduling – Scheduled SMS for Monday, fortnightly for 6 months. 

 
 

Click on the Save Schedule button and this will initiate the Confirmation required which 

includes the Scheduled Message Status displaying the date and time selected.  Clicking on 

Schedule Campaign will send your message at the scheduled date and time. Clicking on Close 

will take you back to allow you to make any changes. 

 

Once message schedules are created, they can be viewed in Scheduled SMS found on SMS > 

Schedule SMS in the main menu. 
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4.5  Merge SMS 
Access this screen by selecting SMS > Merge SMS from the main menu. 

 

 
Figure 4.6: SMS Menu - Merge SMS 

 
The Merge SMS feature performs in much the same way as the Merge SMS facility in a word 

processor, in that each message is personalised for each recipient.   

 

The details of these recipients are not usually stored in your contacts because they change 

on a regular basis.  The recipients could be car insurance policy holders who are to be 

informed that their insurance is going to expire on a specific date.  Each month the list of 

recipients would be different. 

 

A csv (comma separated values) file, containing a list of the recipients’ mobile numbers, 

names, and other information that is specific to each recipient, is imported.  For more 

information on how to create a csv file, refer to Appendix A. 

 
 Before sending messages you must ensure that each recipient has agreed to 

receive this type of message and can opt out of receiving such messages in the 

future.  Recipients must also be able to identify the genuine source of each 

message.  You should read the terms and conditions of use carefully before you 

send out any messages. 
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4.5.1  Importing Recipients 

 
Figure 4.7: Merge SMS: step 1 – Importing the Recipients 
 

Locate the csv file using the Browse button. Select whether your CSV. File contains a 

description row or only date. To continue click next step. 

 

  
Figure 4.8: Merge SMS: step 2 –Reviewing Imported Recipients 
 

Step two shows you a preview of the first 10 lines of your CSV file, using the Mobile Column 

drop down select which column contains mobile numbers, to continue to compose your SMS 

click Continue. 
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 Ensure that there are no dashes (-) separating the digits and that the number is the 

correct length in your csv file. You will not have another opportunity to amend 

your CSV file post upload. 

 

4.5.2  Composing the Message 

 

 
Figure 4.9: Merge SMS: step 3 – Composing the Message 
 

To compose the message manually, type the details in the SMS Message text area.  Where 

details are to be inserted from the csv file, use the Available Merge Fields buttons to insert 

the required personalised data.   

 

To use an existing message template, select the Template from the drop-down list.  You can 

still edit the template in the SMS Message text area.  

 

Sending the Message 

  

The following options are available: 

• To send the message immediately, click on the Preview Import button (refer to 

4.5.3); 

• To send the message at a later date/time, click on the Schedule Options button 

(refer to section 4.5.4); 
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4.5.3  Merge SMS Schedule Options 

 

 

Figure 4.10: Merge SMS: step 3 – Scheduling a Message 
 

To schedule the merged messages for recurrence, refer to section 4.4.   

 

To send the message later and once only, select the date from the calendar and enter the 

time in the edit boxes.   

 

! You will be prompted to acknowledge the terms and conditions of message 

sending in the final step of sending or scheduling. It is important at this point to 

review the total messages about to be sent. It is also important to ensure that you 

are abiding by all relevant marketing and privacy laws.  

 

! It is important that you only click “Send Campaign” once and wait for the screen to 

refresh. 

 

 

 

 

 

 

 
 

Can I Update the CSV File after the message has been scheduled for late delivery? 

No you cannot. When you click on the OK button after setting up the message schedule, 

the CVS file details are stored on the database.  

Any changes you make to the csv file after scheduling the message will not be used. 
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4.5.4  Merge SMS Preview 

 
 

Figure 4.9: Merge SMS Send Report 
 

The Merge SMS Preview gives an example of the message to be sent, the total number of 

messages that will be merged, and the opportunity for individuals to be omitted from the 

merge send.   

 

You are able to de-select any individuals that you would like to be omitted from receiving 

the message. You must de-select, then click Refresh Changes. This will ensure any de-

selected contacts will not receive message and the total number of merge contacts summary 

will be updated.  

 

! The confirmation report does not indicate if any of the messages will exceed 160 

characters once merged.  It is therefore important that when composing the 

message body, the maximum length of each column being imported is considered.  

Do remember that the mobile number is not included as part of the message body, 

and that this does not need to be considered when ensuring that the maximum 

character limit is not exceeded. 

 
To send the merged messages, click on Send Messages button. 

 

! You will be prompted to acknowledge the terms and conditions of message 

sending in the final step of sending or scheduling. It is important at this point to 

review the total messages about to be sent. It is also important to ensure that you 

are abiding by all relevant marketing and privacy laws. 

 

! It is important that you only click “Send Campaign” once and wait for the screen to 

refresh. 
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5 Contacts 
 

Create and manage personal contacts by storing their details (name, surname, mobile 

number and email address - optional) in your contacts to save time and simplify sending. In 

addition to personal contacts, Administrators have the ability to create a global contacts list, 

which can be viewed by all users on the account. 

 

 Only Administrators are granted permission to make amendments to the Global 

Contact list. Standard users can view and use Global Contacts from the contacts list 

on the Send SMS page – they will NOT appear in their Personal Contacts list under 

Contacts. 

 

Access your Contacts by selecting Contacts from the Main Menu. 

 

5.1  Adding Contacts 

 
Figure 5.1: Add Contacts 

 

The above screen shows a user Contacts page where details such as the first name, 

surname, mobile number and email address of saved contacts can be viewed, managed and 

searched. Details on how to add personal contacts are provided below. Refer to 5.5 on 

details on how to search for contacts. 

 

5.2  Manually Adding Contacts 
On the Contacts page, scroll to the bottom and click Create Contact. 

Here, you are required to select the Country Code (+61 for Australia and +64 for New 

Zealand) and fill in the Name, Surname, Mobile Number and Email Address (optional) for the 

contact you wish to add. You also have the option to add the new contact to an existing 

Group – see 5.4 for more details on Groups. 
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 Contacts can be added to Groups at a later stage by selecting them from the 

Contacts list and modifying the group field. 

 

 

5.3  Importing Contacts 
On the Contacts page, at the top click Import Contacts. 

 

Figure 5.2: Import Contacts 
 

The function of importing contacts is a time saving method of adding to personal contacts 

lists. The contact details must be imported from a .CSV file. Refer to Appendix A on how to 

create a .CSV file. 

 

! The .CSV file should contain the following fields: Name, Surname and Mobile 

Number – email address is optional. 

 

Click on the Browse button to locate your saved .CSV file. Using the radio buttons, select 

whether you file includes a Header Row. 

 
Figure 5.3: Allocating Columns 

Using the drop downs, specify which columns contain each of the contacts details – Mobile 

Number, Name, Surname, and Email Address. Click Continue to process. 
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! If your .CSV file does not contain one or more of the details, simply leave the 

dropdown blank. 

 

5.4  Groups 
On the Contacts page, select the Groups tab. 

 
              Figure 5.4: Groups 

Creating contact groups are useful when sending the same message to a group people. Each 

contact can belong to more than one group. Personal contact groups are added here and are 

only visible to the user who creates them. We recommend that you give groups a sensible 

and obvious name to avoid confusion. 

 

5.4.1  Creating New Groups and Adding Contacts 
To create a new group, access the Contacts page, select the Groups tab, scroll to the bottom 

of the page and click Create Group. Give the group and Name and click Save. 

  
Figure 5.5: Adding Contacts to a New Group 
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To add saved contacts to a group 

The following options are available: 

• Add contacts from the Contacts tab; 

• Add contacts from the Groups tab; 

 

From the Contacts tab simply select the checkbox of contacts you wish to add to a group. 

Click on Manage Contacts and select your group from the list. 

 

Click on Groups tab > click on the group you would like to add recipients to. A total number 

of recipients allocated to a group will appear on the right hand side. To add contacts to this 

group, click Add Contacts to Group, which appears under the group total. Clicking Add 

Contacts to Group will open window with a list of current personal contacts. Here, you can 

scroll through or search for contacts to add to the group and save your selection. 

 

5.4.2  Removing a Contact from a Group 
To make changes to Groups, access the Contacts page, select the Groups tab and click on 

the name of the group you wish to modify. 

 

A list of the current contacts allocated to the group will appear. To delete one or more 

contacts from the group, simply select the check box next to the Contact name and click the 

Manage Contact button – select the Remove from Group option to exclude them from the 

group. 

 

5.4.3  Deleting a Group(s) 
To delete a Group entirely, access the Contacts page, select the Groups tab. Select the 

Group you wish to delete by clicking the check box next to its name and click the Manage 

Group button on the top of the page – select Delete Groups. 

 

 



 

ROCKENDSMS ONLINE USER GUIDE DEC15    24 
 

5.5  Find Contacts  
The Contacts page allows you to scroll through your saved contacts as well as use a 

sophisticated Search Bar which will do all the hard work for you. 

 

 

Figure 5.6: Find Contacts 
 

For quick search, use the Search Bar at the top of the Contacts list to type the name, 

surname, mobile number or email address of the contact you are looking for. Alternatively 

you can use the scroll bar to manually search the list or click on column names to sort by 

column. 

 

5.5.1  Modifying Contacts 

To modify the details of a contact, perform a search as described above. Click on the contact 

name to view and manage their details. Make the required modifications and click on the 

Save button. 

 

5.5.2  Deleting a Contact 

To delete a contact entirely, access the Contacts page and select the contact you wish to 

delete by clicking the check box next to their name. Click the Manage Contacts button on 

the top of the page – select Delete Contacts to remove the contact from your list. 
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6 Templates 
The Templates page allows for the modification of existing templates and the creation of 

new templates. 

6.1  Personal Templates 
Access the Templates page by selecting SMS from the main menu and click Templates. 

Administrators have the ability to create global templates, which can be viewed and used by 

all users on the account. 

 

 Only Administrators are granted permission to make amendments to global 

templates. 

  

 Figure 6.1: SMS Menu - Templates 
 

Templates offer a time saving method of sending the same message on a regular basis. 

Personal templates are only visible to the user who creates them. 

 

6.1.1  Creating Personal Templates  
To add a new template, select SMS form the main menu, click Templates and click the 

Create Template button at the bottom of the page. 
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Figure 6.2: Creating Templates 

 

Enter new template Name, select the reply options for the template (these can be modified 

at time of send if necessary) and type in your message. To use merge data from your 

Contacts list, click the Include Merge Fields check box to view the available options. 

 

 If merge fields are used in a message Template sent to a recipient who is not a 

saved Contact, those fields will be left blank in the message. 

 

 Administrators will have the option to save as a Global Template in order to make 

it accessible to all users on the account. 

 

! Remember to make the contents of the message template flexible for re-use. 

 

6.1.2  Modifying Personal Templates 

Access the Templates page by selecting SMS from the main menu and click Templates. Click 

on the template name to open and edit its details. Make the required modifications and click 

on the Save button. 

 

6.1.3  Deleting Personal Templates 

Access the Templates page by selecting SMS from the main menu and click Templates. 

Locate the template in your list and click on the Bin icon in the same row. Follow the 

prompts to delete. 



 

ROCKENDSMS ONLINE USER GUIDE DEC15    27 
 

7  Schedule Messages 
To view Scheduled Messages, select SMS from the main menu, click Schedule SMS. 

 

 Figure 7.1: Scheduled Messages Log 
 

Figure 7.1 above shows the Schedule Message Log screen that displays all scheduled 

messages until they are due for delivery. Once the messages have been delivered they can 

be viewed on the Message Log screen. This tool provides a useful way of keeping track of 

schedules that have been configured. 

 

This page will display a summary of each of the scheduled messages including, date, time, 

number of recipients and message contents. 

 

7.1  Modifying a Scheduled Message 
Select SMS form the main menu and click Schedule SMS. To modify, click on the Campaign 

Name or Scheduled Date of the scheduled message you wish to edit. This will reopen the 

message in the Send SMS screen. Here, you can make and changes to recipients, reply 

options, message body, schedule time, date or frequency and re-save. 

 
7.2  Deleting a Scheduled Message 

Select SMS form the main menu and click Schedule SMS. Locate the Scheduled Message in 

your list and click on the Delete icon in the same row. Follow the prompts to delete. 
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8 Manage Opt Outs 
When conducting marketing or call to action messages that ARE NOT part of a commercial 

business process, messages must contain an Opt-Out provision. One option is to include the 

following wording at the end of the message – “To Opt Out Call (Phone#)”. Another more 

automated process is to allow recipients to reply STOP. You will need to have Allow Replies 

switched ON and set to Replies to Web Inbox/Email. 

 

When recipients respond with the word STOP in their message, Rockend SMS Online will 

automatically place their number into the Opt Outs list. 

 

 This could be in either upper or lower case – the system will accept both as an Opt 

Out request. 

 

Their number will be stored in the Opt Outs list until it is manually removed. Whilst this 

number is in the Opt Outs list, any attempts to send to this number will be blocked. 

 

You can also manually enter a number into the Opt Outs list. 

 

 Ensure you have express permission from the owner of the mobile number prior to 

removing it from the Opt Outs list. 

 

 

Figure 8.1:  Opt-out List 
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9 Reports 
To view message sent and received from your account, select Reports from the main menu 

and click Personal Reports. Rockend SMS Online includes a comprehensive reporting system 

to ensure that every message you send and every response you receive is logged and visible 

at the touch of a button.  

 

 Administrators have added reporting functionality – they are able to view Global 

Reporting which details all messages sent from the account from all users. 

 

 
Figure 9.1: Report Menu – Personal Reports 

 

9.1  Campaign Reports 
This report gives an overall summary of the number of messages sent and replies received 

during a specified period 

 

 
Figure 9.2: Campaign Report 
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The overall status of messages sent during your selected period is demonstrated in progress 

graphs at the top. Each broadcast appears on one line with the following details - Date of 

send, Time of send, Campaign Name, Outbound SMS - the number of recipients sent this 

message, Inbound SMS - replies received from that message by those recipients, Outbound 

Message - message content, Summary  - message delivery status. 

To drill down further and view the recipient details for this campaign, click on in the number 

which appears in the Outbound SMS column for further details relating to that particular 

broadcast. 

 

9.2  Detailed Reports 
Detailed reports reveal all details of each individual message submitted i.e. Sender ID, each 

recipient number, message content and delivery status. You are also able to use additional 

filters such as Phone Number and Delivery Status to drill down on your results. 

 

 
Figure 9.3: Detailed Report 

                 

The overall status of messages sent during your selected period is demonstrated in progress 

graphs at the top. Each individual message sent will appears on one line - Date of send, Time 

of send, Sender ID – indicates the Reply Option used, Recipient – mobile number of 

recipient, Message - message content and Summary  - message delivery status 

 

 If you have enabled Replies for a campaign, the Sender ID will be shown as 

“Replies Enabled”. If you have chosen not to receive replies to your message by 

allocating an authorised alphanumeric Sender ID, this will appear in this column. 

Replies to any of these messages will be indicated with a badge in the Sender ID 

column. 

 

 To drill down further and view the recipient details for this campaign, click on in 

the number which appears in the Outbound SMS column for further details relating 

to that particular broadcast. 
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9.3  Periodic Reports – Daily, Monthly, Yearly 
Periodic reports give you the total number of messages sent per period from your account – 

Daily Report for example is as follows:  

 

 
Figure 9.4: Daily Reports 

 

Summary Tab will show you a total number of messages sent per day for the date range 

specified - each line is broken down into Total SMS sent, the number of broadcasts 

completed and how many of those messages were sent via WebSMS, EmailSMS, API and 

any Replies. 

 

Detailed Report Tab will show you a Detailed Report of messages per day - each message 

sent during your selected period, will appear on a separate line. 
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10 Management (Administrators Only) 
Administrators are able to add and remove users from the account. This is a feature in 

Rockend SMS Online and allows for unlimited user provisions. 

 

 Administrators must be vigilant to remove any users no longer authorised to use 

Rockend SMS Online. 

 

10.0.1  Viewing Current User List 

 

Select Management from the main menu and click User Management. A current list of users 

on your account will appear – drill down; you are able to use the search functions at the top 

of the screen. User details such as Name, Username, User Creation Date and Status will be 

visible 

 

 
Figure 10.1: User Management 

 

10.0.2  Edit User 

 

Select Management from the main menu and click User Management. From the list of 

users, click on the Username of the user profile you wish to modify – user settings open and 

can now be edited. 
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Figure 10.2: Edit User Screen 

 

You can now edit fields such as name, surname, email address, permission, status, cost 

centre, default reply settings, accepted email addresses for EmailSMS and notifications. 

 

10.0.3  Create New User 

 

Select Management from the main menu, click User Management and click the Create User 

button at the bottom of the screen. The new user form will appear: 

Figure 10.3: Create New User 
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Fill in the below details for the user you wish to add to your account: 

• First Name - mandatory 

• Surname - mandatory 

• Email Address - this will become their Username 

• Mobile Number – this is optional 

• Permission – either Standard User or Administrator 

• Status – Active 

• SMS Options – set the default reply options for the user. These can be changed at 

time of sending if necessary. 

• Email to SMS – Enabled by default, add any additional email addresses the user may 

have to enable SMS from email. 

• Notifications - Elect to enable a daily summary email of messages sent from your 

account, email notification of replies to messages sent from Rockend SMS Online 

and whether to send a welcome email with login details to the new user. 
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11 Changing Your Password 
 

Select Setting from the main menu and click Profile & Settings. Under Settings, click the 

Reset Password link and follow the prompts to change your password. 

 

 
Figure 11.1: Changing Your Password 
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12  Appendix A – Creating a CSV File 

A csv (comma delimited) file can only be created using a spreadsheet.  For the purposes of 

the example, MS-Excel has been used.  Open MS-Excel as a blank spreadsheet.  Follow the 

steps below to create a csv file: 

 

• Enter the details required (mobile number, name, etc.) into the spreadsheet using a 

new column for each of the headings. 

• Before saving the spreadsheet, if there is more than one sheet per book, right-click 

on the unused sheet’s tab and select Delete from the pop-up menu.  The csv file 

format does not support multiple sheets per book. 

• Click on the File menu and select Save As.  Select a location and enter a file name.  

Using the Save As Type drop-down list, select CSV (Comma Delimited) from the list.  

Click on the Save button. 

• A warning message appears because there is a possibility that the spreadsheet may 

contain some features that are not compatible with csv.  Click on the OK button to 

continue. 

• The spreadsheet is now ready to be imported by Rockend SMS Online. 

 

The cells that the mobile numbers are in must be formatted as text cells.  To do this, 

highlight the column containing the mobile numbers, right-click in one of the cells and select 

Format Cells from the pop-up menu.  On the Number tab, select Text from the Category list 

and click on the OK button.  If the formatting is applied after the cells were populated, check 

to make sure the mobile numbers still start with a zero. 
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13 Appendix B – Frequently Asked Questions (FAQ) 

 
1 What is SMS?  

2 What is Rockend SMS Online?  

3 How do I access the Rockend SMS Online application?  

4 What do I do if I have a problem logging in?  

5 How do I send an SMS text message?  

6 How do I send a message to multiple recipients?  

7 Can I send more than 160 characters in one message?  

8 Who can receive an SMS text message sent from Rockend SMS Online?  

9 Is there a limit on the number of messages I can send?  

10 How do I recall a message once I have clicked SEND?  

11 How do I view messages that I have sent?  

12 How do I schedule a message for delivery at a later time?  

13 Can I schedule a message for recurring delivery?  

14 How do I view messages that I have scheduled for future delivery?  

15 How do I delete messages that I have scheduled for future delivery?  

16 What is the Contacts List?  

17 How do I add an entry to Contacts?  
18 How do I create a Group in Contacts?  
19 Can I import contacts into my saved Contacts?  
20 How do I search for a Contact?  
21 How do I modify an entry in the Contacts List?  
22 How do I delete an entry from the Contact List?  
23 What is a message template?  
24 How do I create a message template?  
25 How do I modify an existing template?  
26  How do I send a message to a list of mobile phone users who are not in 

my Contacts? 
 

27 Who would use copy + paste bulk numbers?  
28 Why use copy + paste bulk numbers when you have a Contacts List?  
29 What is Merge SMS?  
30 Who would use Merge SMS?  
31 How do I create a Merge SMS message?  
32  Can a user reply to a message that I send? 
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1. What is SMS? 
SMS is a Short Message Service text message that can be sent to or from most mobile phones.  One message part 

is made up of 160 text characters including spaces. 

2. What is Rockend SMS Online? 
Rockend SMS Online is an application that allows you to send SMS messages to mobile phones through a web-

based interface.  It is a fast and easy-to-use communication method to keep you in touch with your employees 

and customers. 

3. How do I access the Rockend SMS Online application? 
To access Rockend SMS Online, visit www.rockendsms.com.au You would have received login credentials upon 

sign up, however if you require these to be re-sent to you, simply click on the “Forgot Password” link under the 

login area. If you are not currently registered for Rockend SMS Online, contact your System Administrator. 

4. What do I do if I have a problem logging in? 
If you are having a problem logging in to the Rockend SMS Online application, please check that you have 

entered your login details correctly.  Your login details are case sensitive; hence, ensure that your Caps Lock is 

not on.  To ensure you are using the correct details, have your login credentials re-sent to you but clicking on the 

“Forgot Password” link under the login area. If you are still experiencing difficulties, contact Rockend SMS 

support@edgility.com.au 

5. How do I send an SMS text message? 

To send a message, select SMS from the main menu and Send SMS from the submenu. Then follow the steps 

outlined below:  

• Select recipients from your Contacts, Groups or manually type the mobile number(s) in the Enter 

Numbers field 

• Configure your Sender ID/reply options 

• Type your message into the SMS Message text area of the screen or select from a pre-saved message 

Template.  One standard SMS messages is a maximum of 160 characters. Rockend SMS Online will 

allow you to exceed 160 characters, but this will be sent as a second message. As you type your 

message, the Characters counter under the SMS Message box, will count characters and messages 

about to be sent.  

• Click on the Send SMS button. Your message will be sent to the recipient you specified.  

 

Recipients whose number is not in the contacts list can be manually typed in the Recipients field. 

6. How do I send a message to multiple recipients? 

To send a message to multiple recipients, select SMS from the main menu and Send SMS from the submenu. 

Then follow the steps outlined below: 

• Select recipients from your Contacts, Groups or manually type the mobile number(s) in the Enter 

Numbers field 

• Configure your Sender ID/reply options 

• Type your message into the SMS Message text area of the screen or select from a pre-saved message 

Template.  One standard SMS messages is a maximum of 160 characters. Rockend SMS Online will 

allow you to exceed 160 characters, but this will be sent as a second message. As you type your 

message, the Characters counter under the SMS Message box, will count characters and messages 

about to be sent.  

• click on the Send SMS button. Your message will be sent to the recipient you specified.  

7. Can I send more than 160 characters in one message? 
Yes, Rockend SMS Online has been designed to allow you to send more than 160 characters. Due to parameters 

set by the carriers, any message exceeding 160 characters will be sent as two messages and any messages 

exceeding 320 characters will be sent as three messages and so on. The recipient will however receive the 
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multiple message as one extended message. The character counter below the SMS Message text area will clearly 

display the length of your message and how many credits required to send. 

8. Who can receive an SMS text message sent from Rockend SMS Online? 

Any mobile/ smart phone capable of receiving SMS text messages can receive an SMS text message from 

Rockend SMS Online.  However, there are some important restrictions on who you can send Rockend SMS 

messages to, and for what reason.  For example, you cannot send marketing messages unless certain criteria 

(including gaining the recipient's consent) are satisfied.  These restrictions are set out in detail in the Rockend 

SMS Terms and Conditions – legislative guidelines are available here: 

 

 View AUS Spam Act  
View NZ Spam Act 

9. Is there a limit on the number of messages I can send? 
If you are a “pre-paid” customer, your company's Rockend SMS System Administrator may have set a monthly 

limit on the number of messages you can send.  Your SMS limit is displayed in Dashboard (home page).  Your limit 

is automatically re-set on a monthly basis.  Unused messages are not carried over to the following month. 

 

If you run out of messages, contact your company's Rockend SMS System Administrator.   Rockend SMS is unable 

to increase your monthly limit. 

10. How do I recall a message once I have clicked SEND? 
You will have a chance to review and confirm the message you wish to send after click Send. The next screen will 

give you a summary of the message and ask you to agree to terms and condition, then click Send Campaign. You 

cannot recall a message once you've clicked on the Send Campaign button.  Therefore, use the confirmation page 

to carefully check the content and message recipients before you send the message. 

11. How do I view messages that I have sent? 
To view messages that you have sent previously, select Reports from the Main Menu. 

12. How do I schedule a message for delivery at a later time? 
To schedule a message for later delivery, follow the steps outlined below:  

• Compose your message in the normal way by entering the message recipients and the message text.  

• Click on the Schedule Options button;  

• Select the delivery date on the calendar;  

• Enter the delivery time in the Hour and Minute fields;  

• Click on the Save Schedule button;  

• Click on the Schedule Campaign option of the dialogue check box after you have confirmed details. 

13. Can I schedule a message for recurring delivery? 
Yes. To schedule a message for recurring delivery, follow the steps outlined below:  

• Compose your message in the normal way by entering the message recipients and the message text.  

• Click on the Schedule Options button;  

• Select the Repeat option from the Schedule Options menu;  

• Make your selections;  

• Click on the Save Schedule button;  

• Click on the Schedule Campaign option of the dialogue check box after you have confirmed details. 

14. How do I view messages that I have scheduled for future delivery? 

To view messages that you have scheduled for future delivery, follow the steps outlined below:  

• Click on the SMS from the Main Menu and select Schedule SMS; 

• Select the message from the list of matching records to view the details or make changes.  

15. How do I delete messages that I have scheduled for future delivery? 

To delete a message that you have scheduled for future delivery, follow the steps outlined below:  

• Click on the SMS from the Main Menu and select Schedule SMS; 

http://www.comlaw.gov.au/Details/C2014C00214/Download
http://www.legislation.govt.nz/act/public/2007/0007/latest/DLM405134.html
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• Find the scheduled message from the list and click on the Trash icon to delete the schedule. 

 

16. What is the Contact List? 

Contact works as your online SMS address book and provides you with easy access to your contacts when you are 

sending messages. 

 
Entries in your Contacts are sorted by Personal addresses or Global addresses.  Contact may be stored as 

individual contacts or group contacts.  Messages can be sent to any combination of individuals or groups in your 

Contacts list. 

17. How do I add an entry to Contacts? 

To add an entry to your Contacts list, follow the steps outlined below:  

• select Contacts from the Main Menu; 

• select Create Contact 

• enter the first name, surname, mobile number and email address (optional);  

• you can add this contact to a group, by selecting the group name from the Add to Group drop-down 

list;  

• click on the Save button. 

18. How do I create a Group in Contacts? 

To create a group, follow the steps outlined below:  

• select Contacts from the Main Menu; 

• select the Group tab; 

• click the Create Group button 

• enter the name of the group in the Create Group edit box and Save;  

 

To add contacts to this group: 

• search for contacts to add to the list;  

• click the check boxes of the contacts you wish to add to the group;  

• click on Manage Contacts dropdown box and select the desired group 

19. Can I import contacts into my saved Contacts? 
Yes, you can import contacts from a CSV file.  For more details on importing contacts, refer to section 5.3. 

20. How do I search for a Contact? 

To find an entry in your Contacts List, follow the steps outlined below:  

• select Contacts from the Main Menu;  

• Begin typing the first name, last name or mobile number in part or full and into the search bar and click 

enter 

21. How do I modify an entry in the Contacts List? 
To modify a Contact, follow the steps outlined below: 

• Select Contacts from the Main Menu;   

• Search for Contact you want to modify;  

• From the list displayed, click on the contact; 

• Make the modifications in the edit boxes and click on the Save button. 

22. How do I delete an entry from the Contact List? 
To delete an entry from the Contacts List, follow the steps outlined below:  

• Select Contacts from the Main Menu;   

• Search for the Contact you want to delete;  

• Tick the checkbox, select Manage Contacts dropdown and select Delete Contacts. 
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23. What is a message template? 
A message template is a pre-saved message that you can select for sending repeatedly.  For example, you may 

want to send a particular message on a regular basis, and, rather than re-type the message each time, you can 

save the message as a template in order to re-use it again.  

24. How do I create a message template? 
To create a message template, follow the steps outlined below:  

• Select SMS from Main Menu and then Templates ; 

• Select Create Template; 

• Name your Template; 

• Select your Reply Options;  

• Type the message text in the box provided;  

• Click on the Save button.  

 

You may also create a template “on the run”. From the sending screen you can enter a manual message and click 

the Save As button. This will allow you to name and save your template.  

25. How do I modify an existing template? 
To modify an existing template, follow the steps outlined below: 

• Select SMS from Main Menu and then Templates ; 

• Select the Template you would like to modify; 

• Make your changes;  

• Click on the Save button.  

26. How do I send a message to a list of mobile phone users who are not in my Contacts? 
In order to send a message to a list of mobile phone numbers that are not in your contacts, you can copy + paste 

a list of bulk numbers directly into Enter Number tab from the Send SMS screen. For more information on bulk 

numbers, refer to section 4.2.2. 

27. Who would copy + paste of bulk numbers? 

Companies who would like to send one SMS text message to a large group of people would use copy + paste bulk 

numbers method.  However, as explained in question 8, there are important restrictions regarding who you can 

send messages to.  These restrictions apply to bulk messages.  Read the Rockend SMS Terms and Conditions very 

carefully before sending bulk messages. 

 

Example:  An insurance company wishes to send a notification message to a group of 100 customers (who have 

opted in to receive these messages) regarding the expiry of their car insurance policy, and request the customers 

to call to arrange renewal. 

 

The message text might read:  'Dear customer, your car insurance policy expires next month.  Please call us on 

130000 to arrange renewal.' 

 
Using the bulk numbers feature, the user can upload or copy and paste the mobile phone numbers of all 100 

customers and the message will be sent to all specified mobile phones 

28. Why use copy + paste bulk numbers when you have a Contacts List? 
The reason for using the copy + paste bulk numbers feature is because the mobile phone numbers you want to 

SMS are not necessarily in your Contacts List. In the above example, where an insurance company sends 

messages to remind customers that their insurance policy is about to expire, the numbers would differ from 

month to month.  Thus, the relevant numbers for each month are provided by an external system. 

29. What is Merge SMS? 

Merge SMS allows you to send an SMS message to multiple recipients, and have the message customised for 

each individual recipient.  Remember that there are important restrictions regarding who you can send messages 
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to, and for what reason.  These restrictions apply equally to messages sent using Merge SMS.  You should read 

the Rockend SMS Terms and Conditions and legislative guidelines carefully before using mail merge. 

 

              View AUS Spam Act  
View NZ Spam Act 

30. Who would use Merge SMS? 
Companies who would like to personalise their communication with staff and customers would use Merge SMS. 

 

Example:  An insurance company wishes to send a notification message to a group of 100 customers regarding 

the expiry of their car insurance policy, and request that the customers call for renewal. 

 

The insurance company has made sure it satisfies the requirement for sending marketing messages (including 

gaining the customers' consent) before it sends this message using Merge SMS.  

 

The insurance company may wish to create a message which includes the customer's name, their insurance 

policy number and the date on which the policy is due to expire.   

 

A file containing the customers' names, insurance policy numbers and expiry dates would be merged with this 

message. 

 

The following are examples of the messages that would get sent after Merge SMS: 

SMS1:  Dear Mr Atkinson, your car insurance policy XY04365 will expire on 30/11/15.  Please call us on 130000 to 

arrange renewal. 

SMS2:  Dear Mrs Barwell, your car insurance policy XY85739 will expire on 05/12/15.  Please call us on 130000 to 

arrange renewal. 

31. How do I create a Merge SMS message? 
For more details on how to create a Merge SMS message refer to section 4.5. 

32. Can a user reply to a message that I send? 
Yes. In the Send SMS screen, you are able to select your Reply option. Options include Web Inbox, where replies 

will come directly back into the Rockend SMS Online Web Inbox (see Web Inbox option under SMS Sending 

Option). You are also able to choose Reply To “Own Number” where replies can be directed back to the sender’s 

mobile number. 

http://www.comlaw.gov.au/Details/C2014C00214/Download
http://www.legislation.govt.nz/act/public/2007/0007/latest/DLM405134.html

